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What’s Enhanced in GMEE 6.3.0 
 

 

The GMEE Outlook integration now enables users to use the standard Outlook buttons to link e-

mail and activities to GMEE, rather than previously used custom buttons (such as “Save and 

Track”).  To link items to GMEE, confirm that the Regarding field is populated before clicking a 

commit button from an Outlook window. 

 
The following features have been implemented in GMEE 6.3.0: 

 

Feature # Feature 

104472 Ability to configure the “Go to” buttons to open an object in the current window, 
rather than in a pop up window 

103548/ 

106939 

Ability to disable the "Export to Excel" functionality  

103364 Ability to execute a QuickAction directly from a dashboard view 

103363 Need feature to allow QuickActions to run for selection of records in the dashboard 
grid. 

103354 Ability to copy a label control with required field indicator 

103338 Tool for converting Standard business objects to Master business objects 

100075 Personalized grid views are retained after logging out  

99365 Ability to use a saved search in the Search and Link dialog box 

99279 Ability to deactivate the "unlink" button in an associated item selector  

98955 Automatically link E-mail to Contact after clicking icon on E-mail tab of Contact 

record 

98489 Support complex logic for creating a campaign segment 

96868 Support for SQL Server 2008 

96838 Ability to prompt for an e-mail template within QuickAction 

96456 Windows Server 2008 support 

78774/ 

78775 

Ability to delete an existing value in a drop-down list  

78511 Ability to handle blank email addresses when using the Run for Group option in a 
QuickAction 

68934 Ability to edit master objects when displayed in a tab  

 
 

 



What’s Fixed in GMEE 6.3.0 

 
The following issues are fixed in GMEE 6.3.0: 

 

Issue # Title 

109521 When committing the Definition Set that has a constraint using a Functional date, 

an error occurs 

109206 Search based on a date field with search criteria of date only does not return the 
correct query results 

107428 Duplicate emails link to record as Inbound and Outbound using Outlook 

integration. 

107391 HTML format emails that contain images, e.g., embedded signature .JPG, will get 

imported into the GMEE database and all text will be converted to lower case 

107387 When using BPML to run the ExecuteQuickAction method in FusionBOWS, the 
response object always returns False 

107239 Unclear error message returned using Outlook Integration 

106864 Merging Account records doesn't merge linked contacts 

106680 Parameters configured to be passed to a Crystal Report are not passed 

consistently, making the report function incorrectly 

106023 Online help for Outlook integration includes extraneous comments 

105540 Unable to send e mail or create appointments or meeting form GMEE to Lotus 

Notes Client on a Citrix environment 

104876 Outlook integration controls interrupt navigation to Opportunity workspace in web 

client 

104686 Client help files are not displayed when client is installed on a drive other than C:\ 

104640 Conditional Visibility Issues on fields within a tab 

104564 Currency conversion from TCV to PCV only works when application server locale is 

United States 

104250 Disconnected GMEE Vista clients cannot validate local specified license file 

104083 No error message is displayed when attempting to save attachment to unavailable 

file server  

103861 Business Process Engine does not properly handle web service responses with 

header elements  

103783 Error when changing the display name of a Master Business Object created from 
an external table 

103545 Custom tab record fields have text when there is nothing in those fields for the 

main record 

102993 Extraneous spaces added to file path copied from one Write To File QuickAction to 

another 

102938 Send E-mail QuickAction does not support embedded images 

102852 Unable to see the FrontRange tool bar in Lotus Notes Client 

102735 Security option needed to disable ‘global’ print capability, while maintaining single 

account print capability for owner 

102732 Security option needed to disable ‘Export to Excel’ functionality in GMEE 

102729 Sample XML file for GMEE does not import with out of the box FAD 

102292 Send or update a task item QuickAction is passing dates in US date format 

102105 Modifications made in the preview are not tracked in the application when using 

QuickAction to send item through Lotus Notes 

101797 Default value is ignored for prompted search 

101169 Link labels (Primary email, Phone number) are not displaying correctly on Vista  

101044 Office documents as attachments can take over 30 seconds to attach or open 



100957 Error when generating forecast using Oracle database 

100956 Trigger using ContactAssociatesActivity relationship does not fire 

100939 Copying a chart dashboard part and modifying it also changes the original 

dashboard part 

100929 Role-based dashboard is not shown in the Navigator 

100925 Pipeline chart uses default date range even if a different range is selected at 

runtime 

100865 Creating an Appointment or Meeting in Lotus Notes does not create a record in 

GMEE 

100830 Cursor state is lost when a user toggles to another application and back to GMEE 

100822 Outlook Add-In installation fails on Windows XP with Outlook 2007 

100078 When new column is added, all previously hidden/removed default columns are 

reinstated 

100072 When creating a new account, the web site of previous account is displayed until 
refreshing 

99941 Custom configuration causes Products/Services to get removed from Opportunity 

when quote is saved after a previous quote was approved 

99890 Forecast Dashboard not rendering properly for non-US locale 

99688 Changed grid views are not showing up with translated perspective 

99546 Cannot use a button added to a form that was configured to execute a Save 
command  

99411 Notes Address Book doesn't sort hyphens properly 

99409 Slow performance when loading records from Notes Address Book 

99408 Lotus Notes Add-In: Uninstall does not remove all installed files 

99406 Address Filters don't work for Notes Address Book 

99405 Calendar "notify me" option should be enabled by default for Lotus Notes 

99404 Add address to the "To" field in the address book it stays until you remove it via 

Delete 

99402 The Personal Address Book works properly as long as you don't have people with 
blank email fields 

99355 Run for Child Records Quick Action when a Master object is related to itself via an 

embedded relationship 

99004 Performance issues when using address book with Lotus Notes Integration 

98960 When a new email is linked to a Contact using 'Save and Track' in Add-in before 

sending the email to the receiver, the Outlook email message window is closed 

and the email is saved in the Drafts folder of Outlook 

98651 Contact icon grayed out 

98578 Funnel Chart displaying ‘Closed Won’ twice in the ‘Opportunities By Stage’ 

dashboard part 

98573 Outlook Integration causes the root of c:\ to be used as temp location for email 

attachments 

98517 The disabling of the green arrow click through (associated item selector) when a 

field is read only 

98516 Attempting to delete manually enter, if the user tabs away the data re-appears 

98513 Application is dropping of the first digit of the date when manually entering a date 
(vs. using pop-up calendar). 

98419 LDAP enabling button is missing in the authentication Settings  

98246 Tabbed dashboard part grid changes do not persist 

97527 Clicking from row to row within a search results set takes approximately 2 seconds 

97525 Drill down option from Funnel chart does not return data. 



97517 Adding large volume of contacts into a new 'Contact Segment' takes over a second 

per contact. 

97324 Go To Drop down in tabbed part works only for grid view 

97113 Cannot configure the objects shown in Outlook Link/Unlink dialog unless 

FRSDefaultSearch is updated 

97104 QuickAction calls to methods do not provide access to method's return value as 

documented 

97066 Column filters on Contact tab on custom object causes contact names to clear 

when changed 

97057 Subscription grid blanks out when selecting filter and is then disabled until 
refreshed 

97024 Custom object data is not visible once filter is applied, based on specific 

configuration 

97021 Linked Calendar Items options configured in Outlook do not work 

97014 Cannot update Public Calendar 

96959 Error message "Invoke or Beinginvoke cannot be called on a control until the 

window handled has been created." when saving linked custom object in specific 
configuration 

96650 Unable to disable "Connect at Startup" option in Outlook Add-In 

96459 Specific custom object causes application to hang when saving an edit  

96141 "System Cannot find the File Specified" message when launching GMEE from Lotus 

Notes  

95920 Unable to get the Ordered List of Records(Data) in a Mail Merge QuickAction. 

95862 Incorrect version number displayed in Help > About when using ClickOnce 

deployment 

95663 Attempting to edit any 'Top X' Runtime option on a 'MultiView Grid' Dashboard part 

included Out-Of-The-Box, results in an error  

95488 When doing a search on the Navigator, for Contact.LastName, then selecting a 

contact record, and selecting the VCR back button the application hangs, and 

inconsistently closes out. 

95111 Field columns added to grid disappear after using back arrow 

94947 When a Contact grid has a relationship with the Account, the count of results of 

search returned on Contact.LastName are inconsistent 

94945 When a Contact grid has a relationship with the Account, the list of Accounts when 

you sort on Contact data is inconsistent 

93901 Master Business Object with name different than the External Table it accesses 
gets invalid object error on save record 

93854 The tab Grid quits working if a filter is set on the fields City and Phone 

93686 Send Or Update Calendar Item QuickAction not functioning as expected 

93437 Save and Track button links open message to GMEE, not the selected message 

83170 When perspective is applied to dashboard part, the dashboard part still appears 

the same as in the base perspective. 

82751 'The criteria is invalid' returned when creating a search with date/time prompt 

82639 When adding a link field, the embedded relationship section of the field wizard 

does not display the full relationship name 

78883 When creating an Organizational Chart with a non-associated category, and 

scrolling down the chart by clicking on the scroll bar GMEE will result in an 

application failure 

78786 Changes are not retained when deselecting objects in the Email/Calendar settings 

77902 When performing a manual merge, child records are only copied to the master 
record if they have a Contains relationship to the parent object 



77832 The option for Simple Value is missing in the right value when setting up an 

Advanced constraint. 

77828 License Manager from the Windows program menu is only available to the user 

who installed it 

77827 Outlook Add-In: Misleading System warning that Office 2003 is not installed and 
therefore the PIA for Office 2003 fails when System has Office 2007 

77774 Dashboard Part with any Chart control will not work if Business Unit Security 

enabled on Group Member Business Object 

77621 The Word mail merge quick action is not fetching the records from the FRS search 

if we have more than one relationship to the same object 

77616 Cannot set the dashboard ‘Corporate User PC Dashboard’ as a default dashboard 

for any workspace 

77476 The word Successful is spelled incorrectly in the BPSETTINGSUTLITY.exe Test 

Connection dialog. 

77017 Personal Dashboards that have been placed on the Navigator are non-functional 

76579 The word ‘separator’ is misspelled on the Field Parser Parameter dialog window 

76567 Error when using spell check with a remote 3 tier connection   

76076 Duplicate searches with same search name can be created by using 'Copy Search' 

and dragging the newly created search to the personal area 

75783 Prompt space diminished when a search is run if the search is built based on 

prompts having more than 4 prompts input parameters 

75596 The "Push" of the relationship does not push the related fields 

75592 Cannot delete a “Push” in the relationship 

75556 After modifying the grid, columns must be de- and re-selected before changes are 
visible 

74885 Search created using a user prompt for date and the date only modifier still 

requires the time 

74576 Edits to grids not appearing on the dashboards after committing definition set 

74312 Exception when generating quote with null fields 

68100 When using the GMEE Smart Client thru ClickOnce, there is a 10 second delay 

when moving between opportunities in the grid view 

67517 Extraneous option available using the "Custom" install option for client 

67498 FAD file is installed through client installation, rather than application server 
installation 

 

 

Installation instructions 

 

Before installing GMEE 6.3.0, backup your current database. Open the Administrator online help 
(C:\Program Files\FrontRange Solutions\FRSApplication\ORAdminWebHelp\ORAdmin.htm) and 

view the section “Exporting data to a FAD file” for detailed instructions. 

1. We highly recommend that customers take an image of current Application Server. 

Note: If you experience any unexpected interruptions or unexpected behavior during the 

install or upgrade process, we recommend that you restore the original image on the 
application server.  In the event that the original image is restored, client machines must 

also be uninstalled and reinstalled with the previous version. 

2. Backup your existing installation (install directory and database).  Copy the Web.Config 
files from each of these locations: 

 



• C:\Program Files\FrontRange Solutions\FRSApplication\ServiceManagement\ 

• C:\Program Files\FrontRange Solutions\FRSApplication\ServiceManagementWeb\ 
• C:\Program Files\FrontRange 

Solutions\FRSApplication\ServiceManagementCrystalReportViewers\ 
• C:\Program Files\FrontRange Solutions\FRSApplication\FusionBOWS 

• C:\Program Files\FrontRange Solutions\FRSApplication\FusionNotification 

 

3. Stop the FSMT service. 

4. Stop the FrontRange Scheduler service. 

5. Stop the Business Process Engine (BPE) as follows: 

• Make sure there is no activity in the AppServer (w3wp.exe). This can be ensured by 

watching the CPU consumed by the AppServer process in the Windows task manager 

or performance monitor. 

• Make sure BPE is not active. One of the ways to find this is to watch the BP Service 

log if the ‘debug’ is turned on or watch the CPU in the task manager.  

• Stop the application pool for the application server in IIS. 

o Go to Administrative Tools>>Internet Information Services Manager>> 

Application Pools. 

o Right-click on Application pool for the application server and select Stop. 
• Make sure the BP Engine MSMQ is empty (0). In case it is not empty and if the 

queue size is decreasing, then wait until it becomes zero. If it does not decrease, 

then it means that the BP Engine is not processing the MSMQ for some reason, in 

which case it is ok to go the next step. 

o Stop the application pool used by GMEE or IIS completely, depending on 

your setup. 

• Stop the BP Engine from Windows Services. 

• Optional steps: 

o Backup the BPE database. 
o Backup the MSMQ directory. 

o Backup the BPE log files. 

• (Optional) Database holding the BPE persistent tables and the database holding 

GMEE tables can be taken offline only after shutting down the App Server, Web 

Services and the BP Engine. 

 

6. Prior to installation, close all active GMEE clients. 
 

7. Stop the FrontRange License Authentication Server. 
 

8. Launch the GMEEServer.exe installation file to install on the application server or Web 
server (if different).  Accept the default settings when prompted. 

 
9. Launch the Upgrade Wizard from the Windows start menu (Start > All Programs > 

FrontRange Solutions > GMEE > Upgrade Wizard).  Accept the default settings when 

prompted and complete the upgrade wizard. 
 

10. Import GMEE63IssueFixes.FUD.   In the FrontRange Administrator, go to Database > 
Upgrade and import the FUD file, which is located in the same directory as the FAD files 

(C:\Program Files\FrontRange Solutions\FRSApplication\GMEE\Fad) 
 

11. Review and apply the changes listed in this document:  GMEE 6.3 Content Upgrade 
Instructions.doc, installed in C:\Program Files\FrontRange 
Solutions\FRSApplication\GMEE\Fad 



• The document includes 6 changes to application settings, which are applied 

within the FrontRange Administrator. 

• The document also describes 18 changes to the application definition.  10 of 

these changes are automatically applied by importing GMEE63IssueFixes.FUD, 
and are mentioned in the document for reference.  The remaining 8 changes are 

indicated in document with the following notation:  “Manual Changes:  Yes”.  

These 8 changes must be applied manually as described in the document. 

 

12. Reset IIS (IISReset). 
 

13. Start application pool for the application server in IIS. 
 

14. Start FrontRange License Authentication Server. 
 

15. Start FrontRange Solutions Scheduler Service (if used). 
 
16. Start FSMT Service (if used). 

 

17. Start the BP Engine: 
• Make sure the Database Server for GMEE and the BP Engine are running. 

• Make sure the Mail Server is up and running. 

• If the App Server is not already up and running, restart the App Server. 

• Start the Web services – FusionBOWS and FusionNotification. 

• Clear or backup BPE debug and error logs. 

• Start the BPE from the Windows Services. 

• Make sure MSMQ is running. 

 
18. Client machines can be upgraded through the ClickOnce installer or by running 

GMEEClent.exe to install manually. 

 
19. There are separate installers for integration with Outlook 2003 and Outlook 2007.  Run 

the appropriate installer for the version of Outlook used on the client. 
 

 

 
 

IMPORTANT: After the installation, all the FrontRange services and IIS must be restarted in 

order to update the application. However, it is not necessary to restart the operating systems. 

 

Help Path Update: 
In order for the GMEE help files to be loaded properly in the 6.3 Foundation, the help path 

setting needs to be updated as described below: 
 

1. Launch the Admin tool. 
2. From the Home screen, click on the “System Settings” link. 
3. From the Settings screen, click on the “Help Settings” link. 
4. In the Help Settings dialog, update the existing settings to reflect the following paths: 

 

Webserver path: /ServiceManagementWebHelp 
Administrator Help Path: /OrAdminWebHelp/OrAdmin.htm 

Application Help Path: /GMEE/GMEEAppHelp/GMEEApp.htm 

 
At this point, the Help Settings dialog box should appear as follows: 



 

 
 

Click the “Close” button, and exit from the Admin tool, to complete this change. 

 

This change is also included in GMEE 6.3 Content Upgrade Instructions.doc, and repeated here 
for emphasis. 

 

 
Special Notes: 

GMEE clients and server must be on the same version and patches. The application will not work 

correctly if clients and servers are on different versions. 

 
• For Auto Deploy clients: 

The following folder must be deleted on each client PC using Auto Deploy. 

 

C:\Documents and Settings\Users Name on Domain\Local Settings\Apps\2.0 
 

 
• Customers performing Complete Installs: 

If you are doing a complete install please note that License Manager “server name” defaults to 

localhost; this should be changed to your actual server name in the FRS Administrator.  

 

Known issues: 

 

Issue Title Work-Around 

93089 Account information is 
not displayed when 

adding a new contact.  

In this case the new Contact is being created using the 
Support View.  There are two ways to resolve this. 

 

1. Set the Contact editing to occur in the tab region: 

1. Launch the Service Management Administrator 
2. Select -> Definition Set ->New Definition Set 
3. In the Tree Control Select the Account Business 

Object 
4. Select Displays, double click on “Account(Layout)” 
5. In the right hand panel right click on the “Contact” 

tab and select “Tab Container Properties” 

6. In the dialog that appears select the “Layout” tab 
7. In the pull down list titled  “Create New Object in” 

select “TabRegion” followed by the “Close” button 

8. Commit the definition set 



Issue Title Work-Around 

9. Close the Service Management Administrator 
10. Reset IIS 

 

2. Or if this is not an acceptable approach , after adding the 

and saving the new Contact Object refresh the Account 

View using the “Refresh” icon in the main toolbar 

103854 UNC path does not 
work in HTML & URL 

enabled fields if 

security credentials are 
required 

If a device accessed by a UNC path requires user 
credentials for access a user must already have logged into 

this resource before it can be access through an active link 

in an HTML or URL enabled field.  
 

104787 Text “<BOD” appears 

automatically. Can't 

enter any text if field 
committed with HTML 

and URL support 

A field that is HTML enabled will store the HTML tags along 

with the visible text.  As such when an ITSM administrator 

adds an HTML enabled field to a Business Object this field 
must be sized to accommodate these tags along with the 

user entered text.  As a minimum an HTML enabled field 

should be the expected size of the user input plus 50 
characters. 

 
105725 URL support for HTML 

enabled fields only 

works if the field is set 
to read only 

The 6.3 release contains support for the following URL 

types in HTML fields: 

file: // 
http:// 

mailto: 

ftp:// 

lotus:// 
callto:// 

For these links to be active the associated field must be set 

to read only.  Since the Admin Security Group typically 
would need to have rights to create this content, users 

viewing this content would need to use a perspective where 
the field has been set to read only. 

 

106574 Knowledge 

Management: MS Office 

2007 and Open Office 
documents get 

'Document not found' 

error when trying to 
open after attaching 

and saving article 

This happens only on Windows 2008 and Vista.  Typically 

the “Document Not Found" error shows up briefly and then 

the document can be displayed. 

106592 Knowledge 

Management:- Does 

not properly save TIFF 

files 

For some systems a files with a .TIFF extension can not be 

rendered when selected from within the document.  They 

can be viewed by double clicking on the file within the 

document tree view. 

106948 Unable to set up 2-tier 

connection to Oracle 

10g (10.2.0.3.0) 

Microsoft introduced changes to the Distributed Transaction 

Coordinator (DTC) with Windows Vista and Windows Server 

2008. Oracle Services for MTS 10.2.0.4 and higher, with the 
exception of 11.1.0.6, support this new DTC when the 

minimum operating system level is Windows Vista with 

Service Pack 1 or Windows Server 2008. 
 



Issue Title Work-Around 

This issue can be resolved by downloading and installing 

the Oracle 11g ODAC components from: 

 

http://www.oracle.com/technology/software/tech/dotnet/ut

ilsoft.html 

 

This includes Oracle Client (11.1.0.7.0) and Oracle Services 
for MTS (11.1.0.7.20).  

 

Installation instructions can be found at: 
http://www.oracle.com/technology/software/tech/windows/

odpnet/install1110720.html 

107127 Recurring Revenue or 

Recurring Revenue by 
territory empty objects 

created. 

This issue has been logged to document a change in 

behavior between GMEE 6.0.7 and GMEE 6.3.  In GMEE 
6.0.7 when a user searches for a Business Object for which 

there are none, the user gets back a dialog box indicating 

that there are “No records found” and the toolbar context 
does not change. 

 
In GMEE 6.3.0  even if there are no matching records, an 

empty search results grid will be shown and the toolbar 

context will change to that Business Object.  With this 
context change the create new button is available and if 

the user permissions allow, a new business object can be 

created.  In the case of an aggregate Business Object a 

user with permissions could directly create new Aggregate 
Business Object records. 

107150 Firefox 3.5.3 – Web 

Client using File ->New, 
there are no up and 

down arrows when 
displaying all objects.  

For most screens the list of New Business Objects will fit on 

the screen and will not require scrolling.  If a users screen 
is such that scrolling is required then an alternate browser 

such as Internet Explorer should be used. 

107444 Lotus Notes Add-in: 

Test Connection throws 

an exception. 

This is intermittent and can be ignored.  If the error occurs 

select the “OK” button to close the dialog and try the test 

connection again. 

108106 Out of the box Reports 
- Need to be rebuilt 

with Crystal Reports 

2008 otherwise the 
new feature "Toggle 

Parameter Panel" won't 
work    

If users would like to take advantage of new features 
available in Crystal Reports 2008 any existing reports will 

have to be rebuilt with the Crystal Reports 2008 designer. 

109682 Attachment (.doc) with 

size greater than 

allowed gives Page Not 

Found Error. 

This error message is misleading; it can be eliminated by 

increasing the size of files that can be attached to a 

Business Object.  This size setting is controlled by the key 

(shown below) that is located in the web.config found in 

the ServiceManagementWeb directory.  The key value is in 

kbytes.  
 

<add key="AttachmentMaxSize" value="3072"/>  

110125 Internet Explorer 8 - 
Web Client:  Selecting 

The process of selecting the “Compatibility View” button 
that displays will either result in a loss of connection and a 



Issue Title Work-Around 

the Compatibility View 

produces a Licensing 

Error  

server error on refresh or will produce a Licensing Error 

dialog.  In either case the user need to log into the 

application again. 

110129 Quick Action Run for 

Group ‘Continue on 

error’ feature does not 

work in some 
situations. 

Some Quick Actions produce errors that will override the 

“Continue on error” selection and result in termination of 

the Quick Action.  No work around is currently available.  

110324 

 
Outlook Add-in: 

Embedded images in 
HTML e-mails - when 

viewing attached e-mail 

in form view, images do 

not show up. 

 

This is an issue with the installation of the 

FusionImageManager virtual directory on a server running 
Windows 2008.  There are 2 options to resolve this issue: 

 
1. Correct the default page for the FusionImageManager as 

follows: 

1. Go to the IIS Manager  
2. Select the FusionImageManager under the 

Default Web Site  
3. Set the Default.aspx as a default page    

 
2. Include the ‘/Default.aspx’ in the Webserver URL location 
as follows: 

1. Launch the Service Management 
Administrator  

2. Select “System Settings” -> “E-
mail/Calendar”  

3. In the “E-mail and Calendar Settings” 
dialog  

a. Select “Mail Settings”  
b. In the “Mail Settings” 

dialog select “Advanced 

Settings”  
c. Add the /Default.aspx to 

the end of the URL under 

“Webserver URL Location 

for Embedded Images”  
d. Select “OK” 

4. Select “OK” and close the Service 
Management Administrator  

5. Reset IIS 
 
 

 

Documentation issues: 

 
Issue Description 
109584 If you want to delete any part of the main query line (the part that begins with 

“Search...”, you must delete the entire FRS Default Search entry from the Search 
Center window, and then create a new FRS Default Search entry with the query you 

want. 

110023 The following information applies to the section on Embedded Image Manager for 



the Outlook and Lotus Notes integration chapters in the Foundation Administrator 

Reference Guide: 

If you want to store the images on a host other than your localhost, enter a UNC 

path that includes the host’s physical name or IP address and an accessible folder. 

For example: 

\\myhost\shared\inlineimages or  

\\10.101.183.37\images 

110035 The icon indicating a reference to another topic in the Document Conventions 

section of the Foundation Administrator Reference Guide is incorrectly listed as “&”. 
It should be the “open book” symbol instead. Refer to any other Foundation manual 

for the correct icon. 
 

In the section “Integrating with Microsoft Outlook”, the following step is no longer 

applicable: 
 

“7. Add columns to Outlook (Outlook). This lets you display a column in your Outlook 

Inbox and/or Sent folder. The column contains a check box indicating whether or not 

an e-mail is linked to a record.” 
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